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WELCOME TO FIRETALK
Firetalk from Multitude, Inc., is a versatile new Internet-based voice communication
service that lets users talk, text chat and Web browse together—simultaneously—over the
Internet in ways that are easier and more powerful than ever before. It’s a nextgeneration communications service that provides a super phone to all its users, and
enables any Website to serve as a voice-chat community.
Firetalk uses sophisticated client-server technology to provide a powerful but easy-to-use
solution for communicating with the widest possible range of PC/Internet users, with the
quickest setup time and lowest learning curve. Unlike other voice products, Firetalk is a
complete set of services for a broad spectrum of scenarios, from one-on-one voice and
chat to large-scale public meeting rooms.
Firetalk’s wide range of features make it the best voice over the Internet service available
today. These features include the following:
1. Firetalk users can make long-distance calls for free and talk with a clear signal to
anyone who has access to a PC and a Web browser—true voice over the Internet.
2. Firetalk provides full duplex communication and voice conferencing, which permits
hands-free natural speech; this means that many people can speak and be heard
simultaneously, just as in a conference call. Unlike other voice services (including
point-to-point services), Firetalk lets many participants speak without resorting to a
push to talk button to be heard.
3. Firetalk users can form spontaneous chat groups, and hold large round table
discussions (up to 1,000 users can participate simultaneously). Firetalk is essentially
one large chat room or voice room, where Multitude, Inc., provides the hosting
services, leaving users free to participate, instead of struggling with the underlying
technology (also, custom chat rooms can be configured for Firetalk partners).
4. Websites become instant voice-chat communities. Firetalk lets users meet others and
communicate interactively, even hosting others on Web sites using their Web
browser, without prior setup. This means that the more than 65 million existing Web
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sites are already voice enabled right now. And through Multitude, Inc.’s partners
programs, any Web site can be customized for hosting site-specific events.
5. Firetalk’s client-server architecture provides key security features. For example,
Firetalk does not transmit Internet Protocol (IP) addresses, making it difficult for
hackers to break in, or for uninvited callers to enter a conference call.
6. Firetalk software and services are free, complete and easy to set up, and the quality of
the voice signal is excellent, even on a 28.8 modem.
7. Firetalk is firewall compatible, and lets users operate within a corporate site (or other
protected environments).
This document describes the key features of Firetalk, its intended audience, and the
basics of how to use it. Its purpose is to give a sense of Firetalk’s integrated capabilities,
how it compares with similar products, and point to some possible areas of opportunity in
the future. Not all Firetalk’s features are covered, and as you use the product, you will
discover added capabilities and benefits not discussed here.

FIRETALK’S AUDIENCE
Because of Firetalk’s versatility, completeness and ease of use, anyone using a standard
PC with a Web browser, speakers and a microphone (or headset) can quickly become a
user—they simply log on to the Firetalk Web site (www.Firetalk.com) and download the
Firetalk installer, and install the application.
Consumers are a logical first audience, and a key market in establishing Firetalk’s ease
and convenience. In addition, its features make it valuable to Web businesses and ecommerce sites, corporations, as well as any service that provides technical support. Over
time, Firetalk is intended to become the standard tool for communities, e-commerce and
corporate Intranets, and will help sites build critical mass by attracting more customers.

Consumers
Firetalk’s initial audience is its many consumer users, who are looking for a simple and
fun way to use voice over the Internet in a robust application that is easy to use—and free
of charge.
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Talk one-to-one over the Internet
In its simplest form, Firetalk lets two people converse over the Internet. Simply by
clicking on the Firetalk icon, a user can call and speak with any other user who is logged
on.
Performance and sound quality are two strong advantages of Firetalk’s design and
implementation. Firetalk is full duplex, so that two (or many) persons can speak
simultaneously in the same voice room. Voice quality is high, even on a low-bandwidth
modem connection (even dial up 28.8 mb/s modems).
Talk one-to-many over the Internet
As in a conference call, Firetalk users can speak simultaneously, as though they were all
in one room together. Firetalk provides one-to-many connections so that users in many
locations can participate in discussions.
Firetalk also provides text chat, so that users can provide text content simultaneously as
they talk; for example, a study group can send quick messages spelling out terms or
concepts, without interrupting a discussion.
Participate in Forums
Any user can participate in an existing public Forum, or initiate a new Forum. The
Firetalk browser provides a list of currently active Forums whenever you log on. Current
Firetalk Forums run the gamut from hobbies, religion, technology topics, personal
growth, cars, marriage and family life, singles, and more.
Firetalk users have created cultural and ethnic group Forums for conversing in their
native languages with people around the world about life back home, work, adjusting to
new cultures, and other personal and professional issues. Unlike text-based chat groups,
each Firetalk user’s computer does not need to be equipped with special fonts, keyboards,
drivers or other language-specific components.
Set up your own Forum
Any Firetalk user can easily set up a Forum, choose topics, assign members, provide
levels of security, and moderate discussions.
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Set up remote study groups
Because it is so easy to get started with Firetalk, students can spontaneously set up a
Forum for Internet-based discussions, Web browsing and show and tell.
Talk with other hobbyists
Hobbies are a natural topic for a Firetalk Forum. Car, motorcycle or sports enthusiasts
can share interests, ask questions, direct others to information on commercial or personal
Web sites, or just listen to someone else tell stories.
Converse with friends and family members
With Firetalk, any family member with Web access can be called for free over the
Internet. Unlike a telephone (that charges by the minute and requires added costs for 3party conversations), Firetalk lets up to 1,000 people talk in real time for free.

e-business
Firetalk provides significant opportunities for commercial customers. Because every Web
site is already voice enabled through Firetalk, commercial services can be enhanced with
real-time voice conferencing and interaction with customers over the Internet.
Voice enable your Web site
Through its Affiliates program (see below), Multitude, Inc. provides each affiliate partner
with their own custom Firetalk voice chat room, anywhere on the partner’s site, at no
cost. This offers a variety of ways for users to voice chat within the Web site, view the
site’s Web pages together, and participate in other site-specific features.
Several community Web sites already have partnered with Multitude, Inc. to provide
added services that other sites cannot provide. For example, Tuneinsports.com has
developed a sports community tailgate party that provides 200 Firetalk voice enabled
pages allowing sports fans to talk sports 24 hours a day. For a commercial site, this same
technology could be used to provide product user discussions, technical support services,
and walk-throughs for products and features, including software products, hardware
installation, online shopping, auctions and more.
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Support customers with real-time simultaneous voice and Web
Technical support groups can use Firetalk to assist customers in real time, not just by
phone or over email. The real-time nature of the Firetalk connection facilitates
communication and speeds the resolution of problems, which can lower tech support
costs and make for much happier customers.

Corporations
Corporations can gainfully use all the features listed above under Consumers and ebusinesses; in addition, corporate users of Firetalk can achieve additional benefits,
including support for Intranets and access to multiple voice conference rooms.
Firetalk also provides unique security features that are of great value to corporate sites.
Unlike other voice products, Firetalk’s security features guarantee that in closed calls or
Forums, uninvited participants cannot enter. What is more, by not transmitting the user’s
IP address, Firetalk avoids exposing corporate Web sites to hackers who try to access
confidential information or imbed viruses.

Partners Programs
The Firetalk partners program currently includes three levels of partnership—affiliates,
associates and strategic partnerships.
Affiliates program
Firetalk Affiliates receive buttons and link instructions, which allow Web site visitors to
easily use Firetalk voice. The Affiliates program provides a global Firetalk voice room
already enabled at the site, and affiliates can create an additional, custom Firetalk voice
chat room for free, anywhere on the site.
Enabled Web sites display the Firetalk enabled icon shown below:
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Associates program
The Firetalk Associates program offers multiple voice conference rooms for users.
Multitude, Inc. will be announcing details of the program as it is developed.
Strategic partnership
Multitude, Inc. is also working on forming strategic partnerships with Web sites that
provide a strong community orientation. Strategic partnerships will be announced as they
are signed up.

USING THE FIRETALK APPLICATION
Firetalk is easy to use and requires very little setup. And it lets you check your settings,
adjust sound volume and test your Internet connection before getting started.

Getting Started
The Firetalk install wizard walks you through the basic setup procedures.
Installing Firetalk
To install Firetalk from the reviewer’s CD, insert the CD that came with this document
and follow the instructions of the installation Wizard.
To download Firetalk from the Web, go to www.firetalk.com and click Download Now.
When the installer file is downloaded onto your computer, double-click on the installer
application (FTSetup.exe) and follow the instructions of the installation Wizard.
When Firetalk is installed on your system, the Firetalk icon appears on your desktop.
Double-click the icon shortcut to start Firetalk (you must be connected to the Internet).
Or, select Multitude from the Programs menu from your Start bar, then select the
Firetalk folder and the Firetalk application icon.
Creating your identity
You need to first create an identity in order to participate in any calls or Forums. The
Firetalk setup wizard prompts you for your identity information when you first install the
program.
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Logging on
The first time you launch Firetalk, the login window appears and prompts you to either
enter your account number (which Multitude, Inc. sends you by email) at the prompt,
Already have a Firetalk account? Or, click the Create New Account button (if you
haven’t already done so in the setup wizard), as shown below.

You must enter your Firetalk account number and password each time you launch the
Firetalk application. Alternatively, you can have the Firetalk application save your
number and log you in automatically each time.
The Firetalk Main Window
When you launch Firetalk, you see the Firetalk main window as shown below:
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The yellow telephone and green Status dot indicates you are live and ready to participate.
This window has two columns of participants’ names:
1. the Contacts column, which includes all the people in your list of contacts for calling,
chatting or sending Instant Messages, as well as Firetalk technical support
representatives (whom you can contact to answer questions about using Firetalk);
2. the Participants column, which includes everyone taking part in a call or Forum.
Until you are in a call or Forum, this list remains empty.
Checking settings
The Firetalk install wizard guides you through the setup of your audio equipment and
Internet settings. Before starting, you can check your settings to make sure the audio
portion is working correctly and at the proper volume. From the Tools menu select from
the following settings:
•

Sound Setup Wizard

•

Mic(rophone) Test Wizard
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•

Internet Test Wizard

•

Volume Control

The first three setting options use the Firetalk Setup Wizard to check the quality of your
sound, recording and Internet connection. The Volume Control is a dialog box for
changing volume.
If you have any trouble connecting to Firetalk, check the Service Status from the Help
menu. This brings you to a Web page that details any Web or Internet problems.
You can also send email to Firetalk support at: support@firetalk.com
What you see when you log on
When you log on, your name quickly appears in the Contacts list (as seen by others, not
by you), and you are available to be contacted. Also, you are able to contact anyone on
your Contacts list.
When you log on for the first time, Firetalk gives you the option of joining the first-time
users chat, so you can hear what other new users are discussing with other users and the
Firetalk technical support representatives.

Calling and Sending Instant Messages
When you have some practice receiving calls and instant messages, you are ready to
contact someone else. When you have found the person’s Firetalk number, you can call,
invite to a Web page or Web tour, or send an Instant Message (text).
Finding a contact
To locate someone who is a registered Firetalk user, click the Add/Find Contacts button
in the main screen. Enter the information you know about the person (first name, last
name, nickname, company, Firetalk number, or email address). Then click the Find
button. Firetalk searches the database of names and displays all persons who meet your
search criteria in the Matching Users scrolling list in the lower window.
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For the fastest search, only enter information in two or three fields, then click the Find
button. You can use an asterisk (*) to perform a wildcard search for any field; for
example, if you are looking for someone whose nickname you believe may be
“superstar,” you can type “super” and click the Find button. Firetalk displays all users
with nicknames that begin with “super,” including superman, superwoman, superduper,
etc.
When you find the name you are looking for, select it and double-click to enter that
person in your Contacts list.
Calling someone
To call someone who is online (whose name has a green dot next to it), you have three
options:
1. Click on the phone icon next to the person’s name;
2. Drag the person’s name to the call area;
3. Right-click on the name and select Call from the popup menu (shown below):
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If the dot next to the person’s name is red, they are in your Contact list, but not currently
online. You can still place a call; if the person comes on line, they will see the Instant
Messaging icon (the flashing yellow note) and be able to reply to your message.
When the person you called answers, the talk bubble appears next to their name in the
Participants list. This talk bubble appears whenever someone is speaking.
Receiving a call
When you receive a call, the icon representing the caller flashes in the Contacts list. Click
the Pickup button to answer the call.
Logging off
To log off of Firetalk, select Logoff from the File menu. The Firetalk icon now displays
OFFLINE. Click Connect to rejoin, or select Login as New User from the File menu to
log in again under a different nickname. You may also select Exit from the File menu to
quit the Firetalk application.
Inviting someone to a Web page/tour
You can also use this menu to invite someone to tour a Web site. This is a major feature
of Firetalk and one that will be expanded and enhanced as the product is more widely
adopted. Select either Invite to Web Page or Invite to Web Tour. If they reply, you are
able to show your guest a Web page or escort them through a Web site, showing them
whatever pages and other features that you wish.
Ending a call
To end a call, click the Hang Up button and your call is terminated.
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Sending an instant message
Right-click on someone’s name, either in the Contacts list or in the Participants list, to
send an Instant Message. The Chat dialog box appears with a text box, and options for
marking the message high priority, and for notifying you when it is received.
Finding out who someone is
To identify someone whose name appears in either the Contacts column or the
Participants column, right-click on the name and select View Info from the popup menu.
Creating a Contacts list
When you first log on to Firetalk, the only names that appear in the Contacts column are
those of the Firetalk Support team. To add names to your Contact list, click the Add/Find
Contacts button (as shown above). To search the Firetalk database for someone, enter
either their Firetalk number (if you know it), or the person’s name, email address, or
company name. If they are in the database, the name appears in the Matching Users
window. When you find the person you want, click on the name and then click the Add
User button.
You can also add a user to your Contact list by right-clicking on their name in the
Participants list, then selecting Add Participant to Contact List.
Changing your personal info/Options
To modify your identity, select Options from the Tools menu, then click on the Personal
Info tab. You can change your password, nickname, company name, personal name,
email address and more. You can also use Options to modify other settings, including
your General Firetalk settings (how the Firetalk application behaves), Internet settings
(for example, if you are behind a firewall, and the default URL for logging onto the
Web), and the Messages that are sent and received when you are busy (see the section
below on Statuses).
Press the Apply button to activate any Options changes. Changes to the Firetalk database
(such as your password or nickname) only take place after you quit Firetalk then restart
the application.
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Forums
When you participate in a Forum, you are able to talk with the entire group using your
voice, not just a keyboard. If you like, you can participate in text chat; Firetalk provides a
range of additional options for communicating.
Joining a Forum
To join a Forum, first display the list of available Firetalk Forums by clicking on the
Forums button in the main window. The Forums list appears as shown below:

Highlight a Forum name, then double-click to join; or, click the Join button in the lower
right-hand corner of the Firetalk Forums window. You may also click the Join button,
then type in the name of Forum in the text field.
A moderated Forum is indicated by a gavel symbol to the left of the Forum’s name.
A Forum marked with a padlock symbol is closed. To join a closed Forum, you must be
invited by one of the Forum participants, or else have the password to the Forum. If you
have the Forum password, double-click on the Forum name, and enter the password at the
Forum Password prompt, and click the Join button.
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Using Chat
To chat with someone in the same Forum as you, double-click on that person’s name in
the Forum list. The Chat dialog box appears with a text box, and options for marking the
message high priority, and for notifying you when it is received.
Using Push to Talk
A key benefit of Firetalk is the way it lets you speak without having to press a talk
button. Alternately, you can choose to keep your microphone turned off until you decide
you want to speak. To keep your voice offline, click the Use Push to Talk button in the
main window. When you want to talk, click the Push to Talk button to activate your
microphone.
In discussions that include seven or more persons, Push to Talk is automatically
activated, in order to reduce the overall noise level.
Using Statuses (Normal, Away, Occupied, Do Not Disturb, Available For Chat, Invisible)
You can select from six choices of Status to decide how you show your availability to
other Firetalk users. From the Options menu, select Status, and you see the sub-menu as
shown below:

Normal is the default value and lets your receive calls and messages. Choose Away to
indicate that you have stepped away from your computer for a short period of time.
Occupied lets you receive incoming messages but not any calls. Do Not Disturb blocks
incoming calls and notifies callers that you are unavailable. Available for Chat indicates
you are looking for someone to talk with. Invisible makes it appear that you are offline.
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Creating a Forum
You can create your own Forum quickly and easily. In the Forum list, click the Create
button. A dialog box appear and prompts you to select a Forum name and password. You
can also choose to make your Forum Moderated, or Hidden (so that non-members can’t
see it listed). Also, you can choose to activate Push to Talk Only, or Broadcast.
Using Conference calling
Conference calling is no more difficult than making a call. You can call one person, then
another, then a third. Other callers can also bring new members into the conference call.

Using Firetalk on the Web
One of Firetalk’s most exciting (and differentiating) features is its ability to enable a Web
site for chat and browsing, which you can do together with other Firetalk users.
Launching Firetalk on the Web
You can surf the site of any Forum that has an associated Web site. When you are in a
Forum, see the Firetalk on the Web button in the lower left-hand corner of the main
window. To launch the Web site associated with this Forum, click the Launch button.
Your browser opens and you are able to share Web browsing with other participants in
the Forum.
Finding Firetalk enabled Web sites
Multitude, Inc. maintains a list of Firetalk enabled Web sites on the Firetalk Web site
(www.firetalk.com). See the Firetalk site frequently for the latest updated lists of sites.
Enabling voice
To enable voice communication on a Web site, click the Enable check box under Firetalk
on the Web.
As shown above (Inviting someone to a Web page/tour), you can bring a guest to a Web
page, or invite them on a tour of an entire Web site. With this feature, Firetalk becomes
much more than a voice over the Internet product, and provides a complete Internet
communications experience, ready to use without any user setup or modification.
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PRODUCT FEATURES
These are the essential product features of Firetalk:
1. Complete voice communication service
2. Web integrated
3. Free to users, both calls and service
4. Firewall compatible (for use inside corporations)
5. Provides security features (does not transmit IP addresses)
6. Installs quickly and easily
7. Simple, intuitive user interface
8. Unique user ID
9. Simultaneous two-way speech (full duplex)
10. Unlimited conferencing (not limited like Yahoo! and others)
11. High quality voice
12. Fully integrated voice and text
13. Instant messaging
14. Live text chat
15. Supports Forums, including user-defined Forums
16. Supports Web touring
17. Off-line message storing
18. One-to-many calling capability
19. Multiple users can talk simultaneously (up to 6)

QUESTIONS FOR COMPARING COMPETITION
When comparing Firetalk to other Internet communications services, it may be useful to
keep the following questions in mind.
•

Does it provide a superior superphone with a clear signal and no long delays?

•

Does it include a convenient and powerful Web integration?
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•

Does it support full duplex/multiple voices simultaneously (i.e., does not require push
to talk)?

•

Does it have instant messaging?

•

Does it provide text chat?

•

Is it firewall compatible?

•

Does it provide security features?

•

Does it support 28.8 modems?

•

Does it provide for partnerships that will help build critical mass of usage and
benefits?

•

Does it allow Web touring?
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FUTURES
Ask Multitude’s representatives to discuss the future of Firetalk, including the following:
1. Enhanced Web browser integration
2. Expanded partnerships with commercial Web sites

SYSTEM REQUIREMENTS
Firetalk has minimal system requirements. Users do need a PC with a full duplex sound
card with speakers and a microphone for real-time voice conversations, as well as an
Internet connection.
•

Pentium 120 MHz

•

16 MB RAM

•

Full duplex sound card

•

28.8 (minimum) Internet connection

•

5 MB free hard drive space

•

Microphone and speakers (headset preferred)
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